6. Virtual Prototype: ARMulator ........................................ 6-1
   6.1. Overview .............................................................................. 6-1
   6.2. Background information ................................................ 6-1
       6.2.1. System synchronization ........................................ 6-1
       6.2.2. ARMulator C hardware model ............................ 6-3
   6.3. Instructions ........................................................................ 6-5
       6.3.1. RGB2YUV ARMulator hardware model ............... 6-5
       6.3.2. Building hardware model using VC++’s NMAKE .... 6-7
       6.3.3. Building & debugging hardware model using VC++ .... 6-8
   6.4. Exercise ............................................................................. 6-13
   6.5. Reference ........................................................................... 6-14
   6.6. Appendix .......................................................................... 6-15
6. Virtual Prototype: ARMulator

6.1. Overview

Virtual prototype enables designer to verify the system early at a higher abstraction level during the development. Virtual prototype can be implemented using SystemC, SpecC, or other high level languages. In this lab, we implement virtual prototype with ARMulator. ARMulator supports adding user designed hardware model to simulate together with its ISS. This lab demonstrates adding an RGB2YUV hardware model into ARMulator. This high level hardware model is written in C using ARMulator's hardware model C constructs. You will learn the followings in this lab:
  1. Be able to write and add C hardware model for ARMulator.
  2. Learn how to write simple drivers for hardware.
  3. Know system synchronization schemes: interrupt and polling

6.2. Background information

6.2.1. System synchronization

In order to let the IPs operate together with the system, synchronization between the ARM core and the IPs is needed. Synchronization lets the processor know when the assigned task of an IP is done, so the processor knows when and where to acquire the results of an IP's task. There are two basic synchronization schemes: interrupt and polling.

Interrupt:
An IP device signals an interrupt when it completes its tasks enabled by ARM core. We say that the IP "raised an interrupt request (IRQ)". This IRQ tells the ARM core that it has finished its task, and requests to be handled.

Figure 1 shows the basic concept when several IPs raise interrupts at the same time. The IRQs are sent to the interrupt controller. Then interrupt controller will check if the IRQs are enabled; if so, it updates the IRQ status registers within itself to indicate which devices requested IRQs. The sorted out IRQ is sent to the ARM core to request the handling for the corresponding IP. The ARM core will stop the current task at a proper time, determine which IRQ should handled first according to programmed priority, and then backup the current CPSR content to the SPSR, so it can resume the original task after finishing handling the IRQ. If it is a nested IRQs, the content of the SPSR would be pushed into the stack. The ARM core will issue the corresponding interrupt service routine (ISR) by checking the interrupt status registers in the
interrupt controller to determine which device requested the interrupt. The ISR shall perform the corresponding operations and then clear the interrupt request by writing a signal to clear interrupt signal of the corresponding IP, which is IP0 in this case. After the ISR is done, ARM core would pop the CPSR’s original content and restore other related context to continue its original task.

IP0, IP1, IP2, and IP3 raised interrupt request (IRQ) at the same time. The IRQs are sent to the interrupt controller.

Interrupt controller receives the IRQs and update the IRQ status indicating the IRQ sources.

ARM core receives the IRQs, determines which IRQ should be handled according to programmed priorities, and then executes the corresponding interrupt service routine (ISR).

The ISR performs its operations and clears the IP0’s interrupt.

**Figure 1. A simple flow of how interrupt works.**

Interrupt enables ARM core to continue working while the IP device has been enabled. Yet the IRQ might be somehow a little unpredictable since you don’t know when the IP device would raise IRQ. Once an IRQ is raised, the core must handle it with its ISR, this would interrupt the core’s original task. And using interrupt requires an interrupt controller hardware unless there’s only one device that would raise interrupt, which is often not the case.

**Polling:**
The ARM core keeps accessing a certain register in the IP which indicates whether it has completed its task enabled by the ARM core for a certain time interval. Once the IP has done its task, the register changes its value, so the ARM core could know the IP is ready and the IP requires to be handled when ARM core accesses the register. The action of continuous accessing and checking the register with a certain time interval is called “polling”.

ARM core polls IP0’s ready register after IP0 has been enabled.

Once IP0 is done with its operation, ARM core will know from the changed value of the ready register.

ARM core will execute the corresponding operations and then disable IP0.

**Figure 2. A simple flow of how polling works.**
Figure 2 illustrates the basic way polling is carried out. The ARM core enables IP0 and then keeps “polling” it. The ARM core checks the ready register of IP0 to see if it has finished its task. After IP0 has done its task, the value of the ready register would change to indicate it has finished its task. When ARM core polls, it will know IP0 is done and can start the corresponding operations after the completion of IP0’s task. The ARM core will finish the corresponding operations and disable IP0. Once IP0 is disabled, the ready register would change to its original not-ready value.

Note that it’s often not possible for ARM core to perform parallel operation with the IP using polling since the core has to keep polling the IP device. And it is up to the software program to determine when to handle the ready IP device. The advantage of using polling is that no additional hardware is required compared to using interrupt synchronization scheme.

### 6.2.2. ARMulator C hardware model

ARMulator supports IP designers to design their IP’s hardware model to run simulations together. ARMulator is a cycle-accurate emulator, it consists of an ARM core instruction-set simulator (ISS) program and several other peripheral modules. New device can be designed with C/C++ language using certain predefined functions interface for hardware modeling with ARMulator. The design is built as dynamic link libraries (DLLs). By adding IP’s hardware model’s DLL and modifying corresponding component description parameters, the hardware model can be included into the simulation.

![Figure 3 Overview of ARMulator](image)

**Figure 3** Overview of ARMulator
An ARMulator hardware model must include ARMulator basic model interface. A basic model interface includes three parts:
1. Data structure declaration
2. Initialization
3. Finalization

**Data Structure Declaration:**
Data structure is declared using `BEGIN_STATEDECL()` and `END_STATEDECL()` macros. Private data structure is declared as follows.

```c
BEGIN_STATEDECL(YourModel)
/*
 * your private data here
 */
END_STATEDECL(YourModel)
```

These macros declare a data structure:

```c
typedef struct YourModelState
    Toolconf config
    const struct RDI_HostInterface *hostif
    RDI_ModuleDesc coredesc
    RDI_ModuleDesc agentdesc;
```

**Initialization**
We use `BEGIN_INIT()` and `END_INIT()` macros to delineate the initialization functions of the model. In the initialization function, your model must initialize any private variable and install any callback. Two variables are provided in the initialization:

- **Bool coldboot**
  TRUE if ARMulator is initializing, FALSE if a new image is being downloaded from the debugger.

- **YourModelState *state**
  A pointer points to the private state data structure. Memory for this is allocated and declared by the initialization macro, and the predefined data fields are initialized.

**Finalization**
We use `BEGIN_EXIT()` and `END_EXIT()` macros delineate the finalization function for the model. The finalization function is called when ARMulator is closing down. The following local variable is provided in the finalization function:

```c
YourModelState *state
```

Your model must un-install any callbacks in the finalization function. The `END_EXIT()` macro frees memory allocated for state.
There are several useful ARMulator functions; you can refer to *ARM Debug Target Guide* for further details on ARMulator hardware modeling.

### 6.3. Instructions

#### 6.3.1. RGB2YUV ARMulator hardware model

The hardware model taken for example in this lab performs RGB2YUV operation. In image processing, red, green, and blue signals are taken in from CCD sensors. However, image encoder such as JPEG encoder adopts luminance (Y) and two chrominance components (U, V) to represent image. Therefore a transformation from RGB to YUV is necessary and is often the first step taken in a JPEG encoder.

The formula to transform RGB to YUV is shown in the following equation:

$$
\begin{bmatrix}
  Y \\
  C_R \\
  C_R
\end{bmatrix} =
\begin{bmatrix}
  0.257 & 0.504 & 0.098 \\
  -0.148 & -0.291 & 0.439 \\
  0.439 & -0.368 & -0.071
\end{bmatrix}
\begin{bmatrix}
  R \\
  G \\
  B
\end{bmatrix} +
\begin{bmatrix}
  16 \\
  128 \\
  128
\end{bmatrix}
$$

### Table 1 Memory map of RGB2YUV

<table>
<thead>
<tr>
<th>Address</th>
<th>Read access</th>
<th>Write access</th>
</tr>
</thead>
<tbody>
<tr>
<td>RGB2YUV_base</td>
<td>RGB2YUV Control register</td>
<td>RGB2YUV Control register</td>
</tr>
<tr>
<td></td>
<td>[31:2]: Reserved</td>
<td>[31:3]: Reserved</td>
</tr>
<tr>
<td></td>
<td>[1]: done bit</td>
<td>[2]: clear interrupt bit</td>
</tr>
<tr>
<td></td>
<td>0: computation NOT done</td>
<td>0: do nothing</td>
</tr>
<tr>
<td></td>
<td>1: computation done</td>
<td>1: clear interrupt</td>
</tr>
<tr>
<td></td>
<td>[0]: enable status register</td>
<td>[1]: Reserved</td>
</tr>
<tr>
<td></td>
<td>0: disabled</td>
<td>[0]: enable register</td>
</tr>
<tr>
<td></td>
<td>1: enabled</td>
<td>0: disable</td>
</tr>
<tr>
<td>RGB2YUV_base + 0x04</td>
<td>Red input register</td>
<td>Red input register</td>
</tr>
<tr>
<td></td>
<td>[7:0]: Red value</td>
<td>[7:0]: Red value</td>
</tr>
<tr>
<td>RGB2YUV_base + 0x08</td>
<td>Green input register</td>
<td>Green input register</td>
</tr>
<tr>
<td></td>
<td>[7:0]: Green value</td>
<td>[7:0]: Green value</td>
</tr>
<tr>
<td>RGB2YUV_base + 0x0C</td>
<td>Blue input register</td>
<td>Blue input register</td>
</tr>
<tr>
<td></td>
<td>[7:0]: Blue value</td>
<td>[7:0]: Blue value</td>
</tr>
<tr>
<td>RGB2YUV_base + 0x10</td>
<td>Y output register</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>[7:0]: Y value</td>
<td></td>
</tr>
<tr>
<td>RGB2YUV_base + 0x14</td>
<td>U output register</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>[7:0]: U value</td>
<td></td>
</tr>
<tr>
<td>RGB2YUV_base + 0x18</td>
<td>V output register</td>
<td>Reserved</td>
</tr>
<tr>
<td></td>
<td>[7:0]: V value</td>
<td></td>
</tr>
</tbody>
</table>
The transform is a 3x3 matrix multiplication and addition. The hardware is assumed to have 3 multipliers and 3 adders, hence 3 cycles are needed to complete a transformation from RGB to YUV. The memory map for this device is listed in Table 1. The based address is set at 0xC2100000 and each register is word aligned.

The procedure of using RGB2YUV is illustrated in Figure 4. A master (ARM or DMA) first load the RGB values by writing Red, Green, and Blue register at offset 0x04, 0x08, and 0x0C. After loaded the data to be processed, the master writes 0x01 to Control register at RGB2YUV base address, which is 0xC2100000. By writing 1 to bit 0 (enable register), RGB2YUV starts computing. Upon completion, the interrupt signal would be set and done bit in Control register would be set also. If synchronization is carried out using interrupt, corresponding ISR for this interrupt will clear the interrupt and disable the device, some may also retrieve the data to a target position. The function call graph of RGB2YUV is illustrated in Figure 5.
6.3.2. Building hardware model using VC++’s NMAKE

1. Search for vcvar32.bat using WinXP’s file search utility.
2. In WinXP, Program Files ➔ Accessories ➔ Command Prompt, a command prompt window appears.
3. Execute vcvar32 in the command prompt. This sets the environment for Microsoft Visual C++ NMAKE utility.
4. Copy RGB2YUV.c into $ARM_INSTALL_DIR\Bin, $ARM_INSTALL_DIR is the install directory of ARM ADS. For PCs in ED414, $ARM_INSTALL_DIR is C:\Program Files\ARM\ADSv1_2.
5. Copy directory RGB2YUV.b into $ARM_INSTALL_DIR\ARMulate\armulext. There is an intelrel directory within this directory, a Makefile is provided in intelrel.
6. Change current directory in command prompt to $ARM_INSTALL_DIR\ARMulate\armulext\RGB2YUV.b\intelrel.
7. Type nmake in command prompt to make the hardware model dynamic link library. The dynamic link library file is RGB2YUV.dll, it is located in intelrel after nmake is completed.
8. Copy RGB2YUV.dll from intelrel to $ARM_INSTALL_DIR\Bin
9. Create RGB2YUV.dsc in $ARM_INSTALL_DIR\Bin with the following content.

```plaintext
;; ARMulator configuration file type 3
{ Peripherals
  {RGB2YUV
    MODEL_DLL_FILENAME=RGB2YUV
  }
  {No_RGB2YUV=Nothing
}
}
```

10. Modify default.ami in $ARM_INSTALL_DIR\Bin, add RGB2YUV part below timer part.

```plaintext
{ Timer=Default_Timer
}

{ RGB2YUV=Default_RGB2YUV
}
```

11. Modify peripherals.ami in $ARM_INSTALL_DIR\Bin, add RGB2YUV part below timer part.

```plaintext
{Default_RGB2YUV=RGB2YUV
 Range:Base=0xC2100000
}
```

12. Open RGB2YUV_demo.mcp project file with CodeWarrior. This project tests RGB2YUV hardware.
13. Make the project and run. The execution results should be the same as follow.
6.3.3. Building & debugging hardware model using VC++

1. Copy `RGB2YUV.c` into `$ARM_INSTALL_DIR\ARMulate\armulext`. Skip this step if you’ve already done so.

2. Copy directory `RGB2YUV.b` into `$ARM_INSTALL_DIR\ARMulate\armulext`. Skip this step if you’ve already done so.

3. Make sure `RGB2YUV.dsc` is added, also make sure `default.ami` and `peripherals.ami` are modified as shown in step 10 to step 11 in 6.3.1.

4. Start Microsoft Visual C++ 6.0

5. File → New to create a new empty project with the following settings. Press OK when you are done.

   Project Type: Win32 Dynamic-Link Library
   Project Name: RGB2YUV
   Location: C:\Program Files\ARM\ADSv1_2\ARMulate\armulext\RGB2YUV.b
6. **Project**→**Add To Project**→**Files** to add following files into $ARM_INSTALL_DIR\ARMulate\armlext to the project

   RGB2YUV.c
   sordi.def
   version.rc

7. **Project**→**Settings**... or press **ALT+F7** to open project settings window.
8. Make sure the drop down list at the top-left displays Win32 Debug. If not, select this option.
9. Click **Debug** tab, choose category "**General**" from the drop-down menu.
   Type **$ARM_INSTALL_DIR\bin\axd.exe** in **Executable for debug session** field.
10. Click C/C++ tab, choose category "General" from the drop-down menu. In Project Options box, change /MTd to /MD.

11. In C/C++ tab, choose category "Preprocessor" from the drop-down menu. Specify ..\..\..\rdi, ..\..\..\clx, ..\..\..\armulif in Additional include directories field
12. Click **Link** tab, choose category "**General**" and replace the contents of **Object/library modules** field with: ..\..\..\clx\clx.b\intelrel\clx.lib ..\..\..\armulif\armulif.b\intelrel\armulif.lib. Type $ARM_INSTALL_DIR\Bin\RGB2YUV.dll. Close **Project Settings** after you complete configuring the project.

13. Build the project by **Build ➔ Build RGB2YUV** or by pressing **F7**. This generates **RGB2YUV.dll** at $ARM_INSTALL_DIR\Bin\.
14. Open RGB2YUV.c source code file and set break points at following lines: 211, 226, 248, and 306 by pressing F9 at the lines.

```c
static void RGB2YUVState(void *handle)
{
    RGB2YUVstate *ts = (RGB2YUVState*)handle;
    rgb2yuv_state = *ts->RGB2YUV;
    Hostif_ConsolePrint(ts->hostif," RGB2YUV done.\n");
    ARMUIf_SetSignal ( &ts->coredesc, ARMPropTH_ARMSignal_IRQ, Signal_On );
}

/*
 Function Name: RGB2YUVClearInterrupt
 Parameters: RGB2YUVState *ts
 Return: void
 Description: Clears the Interrupt source
 */
static void RGB2YUVClearInterrupt(RGB2YUVState *ts)
{
    ARMUIf_SetSignal( &ts->coredesc, ARMPropTH_ARMSignal_IRQ, Signal_Off );
    Hostif_ConsolePrint(ts->hostif," RGB2YUV Int cleared.\n");
}

/*
 Function Name: TICEnableRegisterWrite
 Parameters: RGB2YUVState *ts, rgb2yuv_state *rgb2yuv, ARMWord *word pointer to data to use for write.
 Return: Int - always return 0
 Description: Broadcast function for TICRegisterAccess - the final address decoder - to keep the complexity of one function down a little to keep it readable - this is hand generated not auto-generated code.
 This function performs the processing for a write to the RGB2YUV control registers. It updates the mirror struct members such as enabled/prescale.
 It processes changes to enable and prescale.
 */
static int TICEnableRegisterWrite(RGB2YUVState *ts, rgb2yuv_state *rgb2yuv, ARMWord *word)
{
    /* Update the internal representation first */
    myRGB2YUV=myRGB2YUVEnableChangeMask = (getBit(myRGB2YUV->RGB2YUV_Control,0))|getBit(*word,0);
    myRGB2YUV->RGB2YUV_Control = *word&0x00000000; // Only the least 3 bits are significant : Clear, Done, // Only bit 2 and 0 can be written
}

/*
 static int TICRegisterAccess(RGB2YUVState *ts, ARMWord addr, ARMWord *word, unsigned int *ARMUI_acc, acc)
 { 
  unsigned long maskedAddress = addr & 0xffffffff;
  Hifdef WEBASE
  print("TICRegisterAccess: 0x%llx 0x%llx,\n".unsigned long)addr,
  (word=ARMUI_acc[0]:(unsigned long)word);
  Hendif

  /* Yes it is a memory access - now is it a read or a write? */
  if ( ACCESS_IS_READ(acc) )
  {
    /* Read from registers */
    switch ( maskedAddress )
    {
      case 0x00: //RGB2YUV Control
        // Only the least 3 bits are significant : Clear, Done, Enable
        *word = ts->RGB2YUV.RGB2YUV_Control & 0x00000000;
        break;
      case 0x01: // read red
        Hostif_ConsolePrint(ts->hostif,"read \n");
        Hostif_ConsolePrint(ts->hostif,"\n");
        *word = ts->RGB2YUV.RGB2YUV_Red read \n");
        break;
    }
  }
}
```

15. Press F5 to in VC++ 6.0 to launch AXD and ARMulator. Load RGB2YUV_demo.axf in AXD. Run the AXD image, when RGB2YUV hardware model is triggered, the process will halt at the break points set in step 14.

16. Observe how the hardware model works. By using VC++, you can debug much easier and faster. On occasion without VC++, you'll have to dump out internal information using Hostif_ConsolePrint routine.
6.4. Exercise

Add a new hardware (Matrix Transpose, MT) model. This hardware transposes a 2x2 matrix. The input row data are changed into output column data (\(A=B^T\)). Each data is to be 8-bit data. This operation is assumed to take 2 cycles. The base address is 0xC2110000. Name your module as MT and the name of the source code as MT.c. Then write a simple test program to test your hardware model. Please explain your memory map and source code to TA while demo.

Refer to ARM Debug Target Guide for ARMulator function definitions.

Hint: you can first replace RGB2YUV with MT, replace rgb2yuv with mt.
Virtual Prototype: ARMulator

6.5. Reference

1. ARM Application Note 32: The ARMulator [DAI0032E]
2. ARM Debug Target Guide [DUI0058D]
6.6. Appendix

There are four most common functions we use in this lab. They are ARMulif_Time(), ARMulif_ScheduleUntractable(), ARMulif_SetSignal() and Hostif_ConsolePrint().

**ARMulif_Time:**
This function returns the number of memory cycles executed since system reset. The syntax of this function is:

```c
ARMTIme ARMulif_Time(RDIModuleDesc *mdesc)
```

mdesc is the handle for the core.

**ARMulif_ScheduleUntractable:**
This function is used to schedule a function to be executed after certain cycles. The syntax of this function is:

```c
void ARMulif_ScheduleUntractable(RDI_ModuleDesc *mdesc, ARMul_TimedCallBackProc *func, void *handle, ARMTIme when, ARMTIme period)
```

func is the function to be executed. when is the time for the function to be executed.

**ARMulif_SetSignal:**
This function is used to set the state of signals or properties. The syntax of this function is:

```c
void ARMulif_SetSignal(RDI_ModuleDesc *mdesc, ARMSignalType sigType, SignalState sigState)
```

sigType is the signal to be set. sigState is either on or off.

**Hostif_ConsolePrint:**
This function is used to print some variables in ARMulator via RDI to the console window. The syntax of this function is:

```c
void Hostif_Consoleprint(const struct RDI_HostosInterface *hostif, const char *format, ...)
```
hostif is the handle for the host interface. format is a pointer to a printf-style formatted output string. ... are a variable number of parameters associated with format. For example:

`Hostif_ConsolePrint(state->hostif, "result=%d \n", result);`